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QuarkXPress 4.02

BY PETER DUDAR

ASTROPHYSICIST STEPHEN HAWKING 1S LOOKING FOR A UNIFIED
theory of everything in the universe. On a more down-to-
earth level, graphic designers rhapsodize about a Unified
Publishing Application. Think of it as QuarkXPress, Photo-
shop and Illustrator (plus Director and Dreamweauver?)
rolled into one. Adobe is moving in this direction by creat-
ing a common interface for Photoshop, Hlustrator and Page-
Maker. Problem is, PageMaker is no QuarkXPress.

Since shipping in 1990, QuarkXPress 3 became more
UPA-like with a vast array of third party XTensions. Some of
version 4’s 75-plus new features incorporate functions previ-
ously available as XTensions. Other new functions, such as
bézier tools and clipping paths will be familiar to users of
vector applications like Hlustrator and Freeband, or Photo-
shop-type image editing applications.

isn’t quaint — but it’s timeless.

The tool palette has been subtly enhanced with pop-out
selections added to existing tools, and new icons for bézier
and text path tools. Until you get into certain bézier func-
tions, the contextual Measurements palette is essentially the
same as before. Drop-down menus have been augmented,
not reconfigured. And version 3 keyboard commands still
work. So QuarkXPress 3 users can actually go ahead and
use version 4 without cracking open the manual. And new
functions flow logically from established procedures, so you
can pick them up quickly.

Page icons in the Document palette now display page
numbers that you've assigned with the Section command,
not just absolute numbering.

A new pop-up menu in the lower left corner of your
window displays Pagemaker-like page icons, as a fast alter-
native to scrolling and clicking for pages in the Document
palette.

And you can now zoom up to 800%, using menus or the
Zoom tool.

Enhancements become more apparent when you get into
menus or apply commands. Certain dialogue boxes have be-
come contextual, using a folder tab metaphor. Accessing the
reconfigured Modify dialogue with a photo, for instance,
calls up these tabbed menus: Box, Picture, Frame, Run-
around and Clipping. (Modify [Command-M or CTRL-M] is
now the Swiss Army knife of Quark commands.) The Frame,
Runaround and Clipping commands produce the Modify
box with the relevant tab selected. And text-oriented com-

mands, such as Leading, Formats, Tabs and Rules open the
Paragraph Attributes box in similar fashion.
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Some have voiced concern about the stability of
QuarkXPress 4 — and Quark has released four updates
since its release. Quark’s Fix list (Windows95/NT, Mac OS)
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runs on for several pages and the fixes range from very mi-
nor to significant. Printing and Pictures are the largest prob-
lem categories.

However I ran QuarkXPress 4.01r1 and 4.02r1 on a Mac
G3 under System 8.1 for several weeks with no crashes. And
nothing else has gone seriously wrong. So I have no com-
plaints here.

THE INTERFACE

QuarkXPress 4 looks just like version 3 with a few XTen-
sions — icons and palettes are primarily unchanged. It
seems that two principles have been applied here: if it ain’t
broke, don't fix it; and no messing up the interface with dis-
tracting color and shading. So, maybe the current interface
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The Get Picture dialogue now provides color info, di-
mensions, resolution, size, date and time for any file you
highlight in its menu (DCS 2.0, EPS, JPEG, Photo CD, PICT
and TIFF formats are supported). And you can get pictures
(or multiple-select) with either the Content or Item tool.

You can now Apply all procedures before closing dia-
logue boxes. So adjusting a bit of type with Baseline Shift,
for instance, no longer requires going back to the dialogue
box over and over.

And QuarkXPress now has one user manual, instead of
the awkward two-book system (Using QuarkXPress and Ref-
erence Manual) that shipped with version 3.



BEZIERTOOLS
Bézier procedures in QuarkXPress 4 are a quick study,

since they correspond more or less to those in Illustrator
and Photoshop-type applications. Text boxes can now be
defined with a click-and-drag pen tool or freehand drawing
tool — same with picture boxes and lines. As with other ap-
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plications, you can manipulate curve handles or points as
you draw by using keyboard commands; plus, you can alter
points and line segments afterward, using icons in the mea-
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surements palette. And your boxes or lines, even if non-rec-
tangular, can be anchored to flow with text.

In QuarkXPress 4, a box is not immutably a box. The
Item menu has two conversion submenus: Shape and Con-

The Text to Box command
lets you convert words into
bézier-outlined picture
boxes, then place pictures
within the text outlines.

Group bounding boxes now have
tent. Shape commands let you convert item shapes or types. draggable handles, so you can simul-

For instance, you can change a rectangle into a line or taneously resize multiple items. As

change an ordinary line into a bézier line.

A text box is not irreversibly a text box. Content com-
mands let you convert text boxes into picture boxes and
vice versa. Also, ordinary lines can be made into text paths.

Another conversion command, Text to Box (Style menu),
is particularly amusing. It enables you to convert words into
bézier-outlined picture boxes, then place pictures within the
text outlines.

You can get dramatic (or tasteless) results by combining
conversion commands with other functions. For instance, an
oval text box could be converted into a bézier line (Item >
Shape) — the text now runs along the outside of the oval.
You then flip the text (Modify > Text Path) — and it now
runs along the inside of the oval. Or, if you've converted
text into a picture box (Style > Text to Box), you could
change it back into a word-shaped text box (Item > Content
> Text) and input copy within the letters.

Creating bézier text paths is so easy, I pray they won't
turn up in every new QuarkXPress document. You just draw
a line with the text path tool and add the words. The Modify
dialogue box provides style options.

The Item menu now has complementary Merge and Split
submenus. Merge includes Ilustrator-like commands such
as Intersection and Difference. The Union command merges
overlapping items and also works on non-overlapping
items, making them behave like a single entity. Join End-
points unites adjacent bézier lines or text paths.

The Split submenu enables you to separate a multiple-
path box into its constituents. For instance, a word that has
been converted into a single bézier-outlined picture box can
be split into boxes made of single letters.

Importing custom lines into QuarkXPress 3 and then ap-
plying them as pictures was annoying. Version 4’s Dashes and
Stripes dialogue lets you generate all sorts of single and mul-
tiple line variations, using graphic sliders and numerical en-
try boxes. You can duplicate and edit existing lines or append
lines from other files. Once saved, they can be accessed in
the measurements palette or within frame dialogues.

with single items, you use modifier
keys to scale them proportionally or
include line weights, pictures and text in the resizing.

But despite the move to make QuarkXPress a graphics
contender, Quark has neglected to upgrade the application’s
simple gradients. And two tools that you find everywhere
else just aren’t here: a layer management palette and a soft
shadow creator. You still have to Command-Option-Shift-
click (Mac) or CTRL-Option-Shift-click (Windows) to select
stacked items; or re-order them with Send to Back and Bring
to Front commands — it’s still primitive. (If you're not al-
ready using them, you might want to check out the third
party XTensions XPert Layers or Layer It.) As far as soft
shadows are concerned, you’ll need to get (or re-install)
Shadowcaster or Extensis QX-Effects.

Or exit to Photoshop. A major time waster for page de-
signers is creating graphics in outside applications, import-
ing them, and then going back and forth between applica-
tions, making adjustments out of context. Adding
sophisticated graphics tools to version 4 was supposed to
minimize that. Well, at least the XTension-makers are still
out there to bring Quark’s intention closer to fulfillment.

CLIPPING PATHS

Quark's new Clipping dialogue generates several types
of paths. Picture Bounds creates a path based on the rectan-
gular boundary of the imported file; Embedded Path dupli-
cates a picture-embedded path drawn in Photoshop; Alpha
Channel creates a path based on an alpha channel built into
a TIFF image; and Non-White Areas makes white back-
grounds transparent. Path, Outset and Tolerance controls are
there when applicable. Note that QuarkXPress does not af-
fect the original high-resolution files; it stores the clipping
paths within your document.

Using clipped images with the new Run Text Around All
Sides option enables you to flow single-column text around
one or more objects. (The option is in the Text dialogue, not
in Runaround.)
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CHARACTER STYLE SHEETS
Character Styles enables you to apply formatting to any

highlighted range of text independent of paragraph styling,
and also alter that formatting globally. Unlike character style
XTensions I've tried with version 3, Character Styles in
Quark 4 are efficient and fully integrated into the floating
Style Sheets palette along with paragraph styles. But like in-
dividually altered selections in version 3, you’ll wipe out
Character Style text formatting if you click the No Style para-
graph option. The Style Sheets dialogue enables you to veri-
fy sheets currently in use. And the Append dialogue now
lets you select only the styles you want from another file.
QuarkXPress 4 lets you search and replace style sheets,
using a dramatically enhanced Find/Change palette. Search
parameters can include text and/or attributes (including
font, size and type style). But the palette still does only Find
Next searches — there’s no Search from Beginning of Docu-
ment command. And to access the attributes, you expand
the palette by unchecking the Ignore Attributes box, which
may be the most counter-intuitive procedure ever devised.

LONG DOCUMENT FEATURES

Three new features in version 4 are going to cheer up
long document publishers considerably — indexing, auto-
mated lists and book compiling.
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Index commands reside on a floating palette, where
highlighted text displays automatically. There, you can apply
styles, redefine sequencing (for instance, placing “1998” un-
der “N”) and assign the entry to a level within the index. So-
phisticated Scope options enable you to create cross-refer-
ences or specify that your entry covers a number of
paragraphs, a text selection, or all the text preceding a spe-
cific style sheet.

Since the Index XTension is not activated when you in-
stall QuarkXPress 4 you need to access Utilities > XTensions
Manager to enable it. (Also turn on the CMS XTension if
you intend to use color management features.) If you start
overloading on XTensions, the new Manager lets you create
custom sets.

Like Style Sheets, you set up Lists using the Edit menu —
which makes sense, since Lists are groups of paragraph style
sheets. To create a table of contents you could specify a list
comprised of a Chapter Name style sheet and a Section
Name style sheet. You would then redefine how a style
sheet entry in your list outputs to the table of contents with
yet another style sheet. A floating palette displays all the text
associated with listed style sheets. Producing tables or any
other kind of list with the palette is very simple — just make
a text box and click Build.

In QuarkXPress 3, the only means of manipulating auto
page numbers was the Section command. It worked only
on single files, and numbering was all it did.

A QuarkXPress 4 Book is a set of sequentially numbered
files that use the same style sheets, colors, H&J’s, lists and
custom lines. And a Book can be stored in a shared loca-
tion so multiple users can access and edit its files (chap-
ters). When you create a new Book (File > New > Book), a
floating palette appears. To input a chapter, you just click a
button and browse. Though the parameters reside in a sep-
arate Book file, this first chapter is the master for all that
follow. So if you make a style sheet in a non-master file
and decide to use it throughout the Book, you first append
it in the master file. Then, you click the palette’s Synchro-
nize button, applying it to all the chapters. The Book
palette automatically renumbers your pages as you add
chapters and you can change the sequencing of your files
using arrow buttons.

It seems strange, but the Book palette isn’t accessed in
the View menu like other palettes — it relates to the Book
file, not what's onscreen. So if you close the palette, you
have to re-open it using the File menu.

COLOR MANAGEMENT

EfiColor is now out; Kodak is in. QuarkXPress 4 now
uses device-independent ICC-based (International Color
Consortium) color management, provided with CMS
QuarkXTensions software. Kodak CMM, Kodak PRECISION,
and ColorSync color management system files are installed



on Macs; Kodak Digital Science color management system
files are installed on Windows.

Version 4’s Color Management Preferences dialogue box
lets you select device profiles from Monitor, Composite
Printer and Separation Printer pop-up menus. Then, when
you import visuals, profiles become available in the Get Pic-
ture dialogue box. A Profile Information palette can also be
called up to switch profiles for visuals already on the page.

QuarkXPress 4 supports Pantone Hexachrome color, a
system that produces six color plates instead of four (CMYK,
plus orange and green) and consequently emulates RGB
color more effectively. You can also install Pantone Open
Color Environment (POCE) XTensions software.

A Multi-Ink option lets you create custom colors by mix-
ing process and/or spot colors in your current palettes.

PRINT MANAGEMENT

Features previously available as QuarkPrint XTensions,
are now part of version 4. The Print dialogue has been en-
hanced with tabbed menus: Document, Setup, Output, Op-
tions, Preview and Profiles. The Output menu lets you over-
ride halftone values specified in the Edit Color dialogue
using Frequency, Angle and Function pop-up menus. The
Print dialogue also lets you access separate Printer Setup
and Page Setup dialogues. (You'll still need Page Setup for
PostScript options like Unlimited Downloadable Fonts.) The
dialogue enables you to select continuous and non-continu-
ous page ranges. Included is Quark’s PostScript Error Han-
dler, which indicates where a printing problem originates in
your page and identifies the element (picture box, text box,
line, etc.) causing it. In the Edit menu, a Print Styles dia-
logue, lets you edit, import and export reusable styles.

Font Usage and Picture Usage options are now com-
bined in a tabbed box with a More Information check box.
More Information provides the PostScript name, file name,
font type and version number for a selected font; it provides
the full path, file size, modification date, dimensions and
color depth for a picture.

If you're sending files to version 3 users, you can save
them in 3.3 format, but certain version 4 elements will not
be retained. (Character sheets are deleted, but the text for-
matting survives. Bézier effects, of course, are not retained.)

Installing QuarkXPress 4 requires a CD-ROM and two
floppy disks — an Installer Disk and a User Registration
Disk that you later mail to Quark. Apparently, this strange
procedure is supposed to cut down on illegal copying. Be-
cause of it, PowerBook owners can’t install QuarkXPress 4
without an external CD-ROM drive.

STILL MISSING

Pagemaker users criticize QuarkXPress for not being up
to par in text composition. Since the application composes
text one line at a time without referring to other lines, it can
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end up producing successively loose and tight lines of text.
So type color is inconsistent on the page. Beyond the inclu-
sion of a new hyphenation dictionary, nothing has been
done about text aesthetics.

QuarkXPress 4 still has no table editing controls. Quark
advises picking up an XTension like Tableworks or Entable.
Others point out that QuarkXPress' competitors don’t re-
quire pricey extensions since they all create and edit tables
in-house.

QuarkXPress 4 is the only major publishing application
with no Web export capabilities. I find that incomprehensi-
ble. (One theory is that Quark is trying to make us buy
QuarkImmedia, which produces proprietary non-HTML
code, making it of zero interest to Web developers.) The
only solution is third-party XTensions like BeyondPress and
HexWeb. But for the price of an HTML XTension plus table
XTension you could buy Pagemaker 6.5, with money left
over for a really nice restaurant meal. Also, PageMaker ex-
ports files in PDF format and ships with Adobe Acrobat Dis-
tiller. Quark, so far, has released a PDF Export Filter, still in
alpha version, which still requires Distiller.

Version 3 XTensions for Mac OS, if not redundant, are
still likely to work; but check if upgrades that have been op-
timized for version 4 are available. QuarkXPress 4 has been
rewritten in 32-bit code for Windows. Consequently, Win-
dows XTensions all have to be recompiled and upgraded.

So, if you're using version 3, will you upgrade?

Sure you will — even if QuarkXPress 4 is still nowhere
near the Unified Publishing Application we envision. With
XTensions, it still defines the high end in print publishing.
Because Adobe Pagemaker 6.5 has a lower list price and
doesn’t require a heavy investment in extensions, it's tempt-
ing if you're buying from scratch. But personally, I'd still go
for QuarkXPress 4.

Or you could wait for K2, a Quark-killer application that
is said to be in the works at Adobe.

Supposedly, it’s not a revision of Pagemaker, but an ob-
ject-oriented application that will integrate into a PDF work-
flow. And it may even be combined with lllustrator and
Photoshop. Let me play devil’s advocate briefly: maybe it’s
not that important for publishing applications to bring more
functions in-house. If you've got a professional system with
lots of RAM, it’s not a big deal to keep several applications
running. Maybe integration is all that’s needed. Working for
a magazine, [ exit QuarkXPress most often to use Photoshop,
not Ilustrator. And integrating Photoshop is a problem for
Quark, because Adobe owns Photoshop — and it’s ubiqui-
tous. If K2 pans out, it'll certainly up the ante at the high
end. And we won’t have to settle for merely OK upgrades
from anyone — we’ll experience publishing rapture.

QuarkXPress 4.0 retails for around $1100. Upgrades are
available only from Quark for $300 (US); call (307) 772-
7100. The 4.02r1 update can be obtained at www.quark.com. [
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